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IMPORTANT. READ ATTENTIVELY 
 

Castor-AIR 5.0 FOR WINDOWS 95 
 
 
This License agreement for the End user of an application carried out by Castor 
Software (Castor Environmental Software) constitutes a legal agreement among you 
(either a person or an entity) and Castor Environmental Software regarding the 
software of Castor Software that includes the software and other related means, the 
printed materials (as the user's manual) and any other documentation (software). If 
you install, or you copy or you use this software or the user's manual, you accept 
the terms of the present License agreement for the End user. If you don't agree 
with the terms of this License agreement for the End user, don't install or use 
this product software and their related means; and return it where you acquired it.  
 
 
 

LICENSE OF SOFTWARE 
 
The software is protected by author's laws, by international treaties on copyright 
and by other laws and treaties on the intellectual property. The software carried 
out by Castor Environmental Software is allowed to use with license, it is not 
sold.  
 
Concession of License, The License agreement for the End User grants the following 
rights: 
 

 Software of Applications.- You will be allowed to install and to use a copy 
of the software in a PC. The main user of the PC will be able to make a 
second copy for his exclusive use in a portable PC. 

 
 Storage and use in the net.- You will also be allowed to install or to store 

a copy of the software in a storage device just as a network server.  
 

 However, you will acquire a license for each PC in which you can execute the 
software. You won't be allowed to share neither to use simultaneously in 
different PCs a license for the software. 

 
 Software not for sale.- It is not allowed to resell, or to transfer, for any 

money the software. 
 
 
Other rights and limitations. 
 

 It is not allowed to use technical of inverse engineering. 
 

 The software is granted with license as a unique product. Their components 
cannot separate to be used in more than a PC. 

 
 It is not allowed to rent or to lend the software. 

 
 All the rights shown in the License agreement for the End user can only be 

transferred with the condition that the receiver accepts the terms of this 
License agreement for the End user. 

 
 Without prejudice of any other right, Castor Environmental Software can 

finish this License agreement for the End user if you don't fulfill the terms 
and conditions of the contract. In this case, you will destroy all the copies 
of the product software and their components. 

 
Copyright:  The ownership and copyright with regard to the software, the printed 
materials that accompany it and any copy of the product software is property of 
Castor Environmental Software. The software is protected by copyright laws and by 
international treaties. Consequently, you will try to the software like any other 



Castor-AIR environmental  software 

 

 IV 

material subject to copyright with the difference that you will be allowed to 
install the software in a single PC. It is not allowed to copy the printed 
materials that accompany to the software. 
 

****** 
 

The parties to this agreement are Castor Software, hereinafter referred to as 
"Castor Environmental Software" the Castor-AIR software user hereinafter referred to 
as "Licensee." 
 
EFFECTIVE DATE: This agreement shall take effect upon execution. 
 
LICENSED MATERIALS: Castor Environmental Software hereby grants to Licensee one (1) 
non-exclusive, non-transferable, and royalty-free license to install the Licensed 
CASTOR-AIR system (application and user’s manual) on one computer, which is 
incorporated herein by reference. One computer is defined as one unique combination 
of Operating System(OS)/ Processor(CPU) / Hard Drive(HD). 
 
LICENSE PROVISIONS: Castor Environmental Software shall have no obligation to 
provide support, including but not limited to installation, maintenance, debugging 
and improvements, for Licensed Materials, except as Castor Environmental Software 
at its sole discretion, shall determine to be reasonable. Licensee agrees to make 
available to Castor Environmental Software any modifications or enhancements to the 
Licensed Materials provided under this agreement. Castor Environmental Software 
shall have the right to use such modifications and enhancements for any purpose 
whatsoever. 
 
NOTICES: Any notices required to be given or which shall be given under this 
agreement shall be in writing delivered by first-class mail. Notices shall be 
addressed to the parties as follows: 
 

License Manager 
Castor Environmental Software, C.P.   
  
28034 Madrid, Spain 

 
WARRANTIES: Licensee agrees to accept the Licensed Materials on an "as is, with all 
defects" basis. Castor Environmental Software makes no warranties, express, implied 
in law or in fact, including any implied warranty of merchantability or fitness for 
a particular purpose, or results obtained from Licensee's use of Licensed 
Materials, or that the use of any Licensed Materials will not infringe on any 
patent, copyright or trademark or other rights. 
 
LIABILITY AND INDEMNIFICATION:  Castor Environmental Software shall not be liable 
for any manner of loss or damage arising out of the use of  the materials provided 
hereunder. Further, Castor Environmental Software shall not be obligated to 
indemnify the Licensee in any manner for any loss which Licensee may experience, of 
any kind or nature, arising out of the use of the materials. 
 
ASSIGNMENT: This agreement shall inure to the benefit of and be binding upon the 
parties, and their respective successors and assigns. This agreement shall not be 
assigned by either party without the written consent of the other party thereto. 
 
GOVERNING LAW: This agreement shall be interpreted, enforced and construed 
according to the laws of the Kingdom of Spain. 
 
ENTIRE AGREEMENT: This agreement contains the entire agreement between the parties 
with respect to the subject matter hereof, and it shall not be modified or amended 
except by an instrument in writing signed by both parties hereto. 
 
 
 
 

Castor Environmental Software, C.P. 
 
28034 Madrid, Spain 
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DISCLAIMER 
 
 The present document has been carried out by Castor Environmental Software, 
in its entirety. Any mention that we can find in the manual of companies, official 
organisms, names, products or trademarks don't imply the participation of these in 
the realization of the present document neither in the development of the software. 
On the other hand, the mention that we can find in the manual of companies, 
official organisms, trade names, products or trademarks don't mean that they are 
recommended by Castor Environmental Software, . The information contained in this 
document has been obtained by Castor Software of credible sources. Nevertheless, 
Castor Software doesn't guarantee the accuracy or perfection of the published 
information. Castor Software won't become responsible for any error, omission or 
damage caused by the use of the information of the manual present and of the 
software. With the use of the software and manual, Castor Software is not providing 
any specific professional service to carry out technical studies. Specialized 
professionals, hired for this, will carry out the pertinent studies. 
 
 The CASTOR-AIR  software estimates the dispersion of pollutants in the air. 
These types of numeric simulations are a method to estimate the contamination in an 
approximate way. Castor Software doesn't guarantee that the results obtained by 
this program coincide with the real concentrations that we can find in the air. The 
software, the used algorithms and the manual have been conscientiously examined of 
the possible existence of errors or omissions. Although we have checked the 
operation of CASTOR-AIR  keeping in mind the results that we can find in the 
existent scientific literature on the area, Castor Software is not responsible for 
errors or omissions that we can find in the software, in the used calculation 
algorithms and in this manual. Castor Software is not responsible for losses or 
damages caused by the use of this software or of the user's manual. This software 
has been conscientiously examined of the possible existence of computer virus 
before its distribution.  
 

Although we have used programs up-to-date antivirus of last generation and we 
have taken the maximum cautions in the development of the program and of the 
installation system, Castor Software is not responsible for losses or damages 
caused by these. We recommend that it maintains backup copies of all their 
fundamental data before installing the CASTOR-AIR  software. 
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FOREWORD 
 
The numeric algorithms that CASTOR-AIR  uses gives us the possibility to study a great quantity of air 
pollutants that we find in our environment. The numerical method uses a equation that estimates the 
dispersion of the pollutants in the air.  
 
The software admits meteorological data to establish the form of the polluting plume. The software 
calculates the pollutant concentration that is produced by each one of the sources and it considers the 
estates of the pollutant and the state of the winds. CASTOR-AIR  carries out temporary averages 
(daily, monthly or annual) so that you can calculate the concentration average in each point of the 
affected area.  
 
The system of simulation of processes of dispersion that CASTOR-AIR  has, offers to the beginner 
and the expert programmer, a quick and practical system to evaluate the dispersion of pollutants in the 
air. The program is based on the operating system Microsoft WINDOWS where one works intensively 
with the mouse and the graphic windows. The bars of icons facilitate the realization of the different 
tasks of the program. We can say, with a certain security that the software CASTOR-AIR  is one of the 
best tools, to carry out numeric simulations of air pollution processes. Without considering the 
experience that the user possesses in programming languages or in the use of simulation tools, in few 
minutes he will be able to have the first results.  
 
This manual will describe the use and the possibilities of CASTOR-AIR that we will show with the use 
of examples. It is not strictly necessary possessing knowledge on the handling of the operating system 
of Microsoft WINDOWS although it is advisable. Along the user's manual we will simulate some air 
pollution processes whose development will illustrate the use of the program in the case of complex 
systems. We will describe the necessary steps for the study of a air pollution process with the 
software.  
 
Finally, we will say that they exist in the scientific literature a great quantity of models to evaluate the 
dispersion of pollutants in the air. In this way, we will obtain numeric differences among the results of 
the program and the results of other numeric models. This is not strange since there are numeric 
differences among the different models of the scientific literature. The problem is that the dispersion is 
a complex physical phenomenon (that involves turbulences, non-linear dynamics and thermodynamic 
of the irreversible processes) and we want to simplify it with a simple equation. On the other hand, we 
will add that this approach type is, today per today, the most reasonable that we can think about to 
evaluate the air pollution.
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1. Introduction 

  
 

Our planet is fragile and limited as for its potential of 
generating the resources that the humanity requests and her 
capacity to absorb the residuals that we emit. The 
precariousness of the ecological and environmental resistance 
of the earth can end up threatening the humanity's 
development. IUICN, PNUMA, WWF and Agenda 21 plead insistently 
to reach the sustainable development. This admits a growth and 
an evolution of the carrying capacity of the ecosystems, 
without committing the necessities of the future generations, 
by means of the environmental administration of the different 
places of the Planet. 

 
 

2. Administration and Environmental Impact 
 
 

The environmental administration is based on two 
fundamental tools:  the planning and the evaluation of the 
environmental impact. These two instruments are fundamental to 
coordinate the human activity and to maintain the quality of 
the environmental resources. The process of environmental 
planning combines the characteristics of each place with the 
possibilities of economic development. We will define 
administration objectives that will achieve the optimization 
of the use of the resources minimizing the impact generated on 
the environment. We will define the environmental impact that 
suffers a certain region as the difference among the future 
environmental situation of the place, after the realization of 
a project, and the environmental state of the area if this 
project had never taken place.  The correct diagnosis of the 
impact demands to know all the elements implied in the 
environmental process. A study of environmental impact will 
also include a planning of the environmental surveillance of 
the project.  

 
 One of the fundamental physical systems for the study 
of the environmental quality of a region is the atmosphere. 
The atmosphere play a fundamental paper in the development of 
the life. In this software, we will center ourselves in the 
study and in the administration of the air quality.  
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3. The Atmosphere 
 
 

The atmosphere supports photosynthesis and respiration. 
It is a source of nitrogen for nitrogen-fixing plants and 
nitrogen-fixing bacteria. The atmosphere transports air vapour 
and protect the Earth from cosmic rays and UV radiation. The 
atmosphere absorbs much of the infrared radiation, thus 
stabilising the Earth’s temperature at a level which will 
support life. Short-term changes are described as weather and 
long-term changes as climate. The movement of masses of air 
that occurs horizontally is called wind. It takes place from 
regions of high pressure to regions of lower pressure. The 
movement of air masses transfer heat from the ocean to land. 
The temperature of the atmosphere varies with height and forms 
the basis for one classification of the atmosphere into 
layers. 

 

3.1 The Greenhouse effect 
 
 
Energy is received by the Earth from the Sun and is radiated 
back into space. Earth temperature is maintained at an average 
of 15 degrees. A mechanism for doing this is the greenhouse 
effect. Energy is lost from the Earth by conduction and 
radiation. In fact, about half of the solar radiation which 
enters the atmosphere reaches the Earth surface. An increase 
in the carbon dioxide level of the atmosphere could prevent 
sufficient energy loss and cause a damaging increase in the 
Earth temperature. Other greenhouse gases are methane, 
dinitrogen oxide, carbon monoxide, ozone and CFCs.  

 

3.2 The Ozone layer 
 

There is a layer of ozone in the Stratosphere and there is a 
natural balance which keeps the ozone layer at a constant 
thickness. It is effective in filtering out dangerous UV-B 
radiation (290-320 nm). Ozone is destroyed by chemical 
reactions with a number of substances that occur naturally in 
the Stratosphere. Man-made substances are now attacking the 
ozone layer and reducing its thickness. 
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4. Air pollution 
  

Waste matter is released into the atmosphere from a variety of 
pollutant sources. Atmospheric pollutants area serious threat 
to health. The pollutants present in the atmosphere are: 
particulate solids, droplets of liquids and gases. It is 
convenient to classify pollutants as primary pollutants which 
are emitted directly into atmosphere and secondary pollutants 
which are formed in the atmosphere from primary pollutants. 
 

4.1 Particles 
 
Parcicules, alternately referred to as Particle Matter (PM). 
Aerosols or fine particles are tiny particles of solid or 
liquid suspended in the air. They range in size from 10 nm 
(nanometer) to 100 um (micrometer) in diameter. The 
composition of fine particles depends on the source. The 
deposition site is a function of particle size. Larger 
particles are generally filtered by the nose and do not cause 
problems, but particulate matter smaller than about 10 
micrometres (PM10) can settle in the lungs and cause health 
problems. Particles emitted from modern vehicle engines are 
typically in the size range of 100 nanometres.  

 

4.2 Lead 
 
Lead enters the air from lead tetraethyl which is added to 
petrol as an antiknock. Lead from atmosphere pollutes the 
land. Vehicles exhausts are the chief source of lead 
pollution. 
 

4.3 Carbon monoxide 
 
Carbon monoxide, which is primarily emitted from combustion 
process, particularly from vehicle exhausts; the highest 
concentrations are generally found at roadside locations. 
Inhalation of high levels of carbon monoxide can cause 
headaches and respiratory problems. Carbon monoxide has many 
common sources. The exhaust of the internal combustion engine, 
when burning a carbon-based fuel contains carbon monoxide.  
In the home, carbon monoxide (CO) gas forms when fuels like 
natural gas or wood do not burn completely in appliances such 
as air heaters, ranges and ovens.  
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4.4 Sulphur dioxide 
 
Sulfur oxides, which causes acid rain is caused from the 
burning of fuel containing sulfur, mostly at power plants. 
Sulphur dioxide reacts with air doplets to form acid rain. 
 

4.5 Oxides of nitrogen 
 
Emissions are primarily in the form of NO, which is oxidised 
by ozone (O3) from nitric oxide to NO2. Nitrogen dioxide (NO2) 
is the primary concern for effects on health. The various 
oxides of nitrogen can also react with hydrocarbons in the 
atmosphere to contribute to photochemical smog. Oxides of 
nitrogen can also affect ecologically sensitive sites through 
deposition, causing acidification.  The term nitrogen oxide 
can be used to refer to any of these oxides (oxygen compounds) 
of nitrogen: Nitric oxide (NO);  Nitrogen dioxide (NO2);  
Dinitrogen oxide (N2O) (Nitrous oxide);  Dinitrogen trioxide 
(N2O3);  Dinitrogen tetroxide (N2O4); Dinitrogen pentoxide 
(N2O5). A mixture is often formed in chemical reactions that 
produce nitrogen oxides, with the proportions depending on the 
specific reaction and the conditions it is performed in. When 
dissolved in atmospheric moisture the result can be acid rain 
which can damage both trees and entire forest ecosystems.In 
atmospheric science the term NOx is used to mean the total 
concentration of NO plus NO2. During daylight NO and NO2 are 
in equilibrium with the ratio NO/NO2 determined by the 
intensity of sunshine (which converts NO2 to NO) and ozone 
(which reacts with NO to give back NO2). Three primary sources 
of  Oxides of nitrogen formation in combustion processes are: 
prompt NO, fuel NO and thermal NO. Thermal NOx formation is 
recognized as the most relevant source when combusting natural 
gas. 
 

4.6 Acid rain 

 
Acid rain is defined as rain with a pH of below 5.6. Normal 
rain has a pH of slightly under 6, which is slightly acidic. 
This natural acidity is caused by dissolved carbon dioxide. 
Acid rain is caused by sulfur from impurities in fossil fuels 
and nitrogen from the air combining with oxygen to form sulfur 
dioxide and nitrogen oxides. These diffuse into the atmosphere 
and react with air to form sulfuric and nitric acids which are 
soluble and fall with the rain. Some The resulting increased 
acidity in soil has proven to be harmful to vegetation.  
Principal sources are industrial and power-generating plants 
and transportation vehicles. The gases may be carried hundreds 
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of miles in the atmosphere before they are converted to acids 
and deposited.Since the industrial revolution, emissions of 
sulfur and nitrogen oxides to the atmosphere have increased. 
Industrial and energy-generating facilities that burn fossil 
fuels, primarily coal, are the principal sources of increased 
sulfur oxides. The toxic ions released due to acid rain form 
the greatest threat to humans.  
 

4.7 Organic pollutants 
 
Volatile organic compounds are organic chemical compounds that 
have high enough vapour pressures under normal conditions to 
significantly vaporize and enter the atmosphere. A wide range 
of carbon-based molecules, such as aldehydes, are volatile 
organic compounds. Common artifical sources of volatile 
organic compounds include paint thinners, dry cleaning 
solvents, and some constituents of petroleum fuels.  Volatile 
organic compounds are an important outdoor air pollutant. In 
this field they are often divided up into the separate 
categories of methane (CH4) and non-methane. Methane is an 
extremely efficient greenhouse gas which may contribute to 
enhanced global warming. Within the non-methanes, benzene may 
lead to leukaemia through prolonged exposure. 1,3-butadiene is 
another dangerous compound which is often associated with 
industrial uses. Volatile organic compounds are often used in 
paint, plastics, and cosmetics.  
 

4.8 Photochemical smog 
 

Photochemical smog is caused when two kinds of air pollution 
combine in the presence of sunlight. The first kind is the 
particulates and nitric oxides from the exhaust of fossil 
fuel-burning engines in cars and  coal power plants. The 
second kind is the emission of volatile organic compounds from 
paints, solvents, and other chemicals.  Smog is a problem in a 
number of cities and continues to harm life. High levels of 
smog aggravate and even cause human respiratory problems.  
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5. Air quality and pollutant emissions 
 

 

CASTOR-AIR software uses g/m3 in the input data window. If the 
pollutant concentrations are in parts per million (ppmv), we 
can change to ug/m3 as follows: 

 
(c in micrograms per cubic meter)=M/0,02404 (c in ppmv) 
 
being M the molecular mass of the pollutant. At 20C (Celsius 
degrees) and at 1 atm, we have the next relations that can be 
useful:  

 
 
 

pollutant ppmv micrograms/m3 
SO2 1 2610 
CO 1 1140 
NO2 1 1880 
H2S 1 1390 

 
 

5.1 Air quality indexes 
 
There are different air quality indexes in the world. The 
ORAQI air quality index has the next upper limits: 

 
  

Pollutant SO2 Particulate 
matter 

NO2 CxHy CO Pb 

concentration 
(ug /m3) 

350 250 200 140 20,000 4 

 
 
 
 
The World Health Organization, Federal and Germany air quality 
indexes have the next upper limits: 
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Pollutant Period Federal WHO Ta Luft (Germany) 
CO 15 min 

30 min 
1 h 
8 h 

 
 

40,000 ug/m3 
10,000 ug/m3 

100.000 ug/m3 
60.000 ug/m3 
30.000 ug/m3 
10.000 ug/m3 

 
 

30.000 ug/m3 

10.000 ug/m3 
NO2 1 h 

24 h 
annual 

 
 

100 ug/m3 

400 ug/m3 

150 ug/m3 
200 ug/m3 

80 ug/m3 

O3 1 h 
24 h 
100 days 

235 ug/m3 200 ug/m3 

65 ug/m3 
60 ug/m3 

 

SO2 10 min 
1 h 
3 h 
24 h 
annual 

 
 

1,300 ug/m3 
365 ug/m3 
80 ug/m3 

500 ug/m3 
350 ug/m3 

 
125 ug/m3 
40 – 60 ug/m3 

 
 

400 ug/m3 
140 ug/m3 
60 ug/m3 

PM-10 24 h 
anual 

150 ug/m3 
50 ug/m3 

125 ug/m3 
50 ug/m3 

150–300 ug/m3 

SO2+PM-10 annual  60 – 90 ug/m3  
Pb 3 months 

anual 
1,5 ug/m3  

0,5 – 1 ug/m3 
 

2 ug/m3 
PM + PM-10 24 h 

annual 
260 ug/m3 
75 ug/m3 

  

Hydrocarbons 3 h 160 ug/m3   
 

 

5.2 Pollutant emissions 
 

In this section, we will show typical emission values that can 
be used as input data in the CASTOR-AIR software: 

 

Typical coal boiler emissions: 
 

Coal boiler 
power 

Coal kg per 
second (kg/s) 

SO
x 

NO
x
 CO 

100 MW 3,3 g/s 201 g/s 48 g/s 0,8 g/s 

500 MW 16,5 g/s 1.005 g/s 240 g/s 4 g/s 

1.000 MW 33 g/s 2.010 g/s 480 g/s 8 g/s 

1.500 MW 49,7 g/s 3.023 g/s 721 g/s 12,4 g/s 

2.000 MW 66 g/s 4.020 g/s 960 g/s 16 g/s 
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Typical fuel oil boiler emissions: 
 

Boiler power Fuel oil liters 
per second (L/s) 

SO
2 

NO
x
 CO 

50 MW 1,2 g/s 72 g/s 6,7 g/s 0,7 g/s 

100 MW 2,4 g/s 144 g/s 13,4 g/s 1,4 g/s 

150 MW 3,6 g/s 210 g/s 20,2 g/s 2,1 g/s 

200 MW 4,8 g/s 280 g/s 26,8 g/s 2,8 g/s 

300 MW 7,2 g/s 432 g/s 40,2 g/s 4,2 g/s 

 

 

 

Typical butane boiler emissions: 
 

Boiler power Liters of butane 
per second (L/s) 

SO
x 

NO
x
 CO 

3 MW 0,11 g/s 0,0079 g/s 0,28 g/s 0,047 g/s 

10 MW 0,37 g/s 0,027 g/s 0,93 g/s 0,159 g/s 

20 MW 0,74 g/s 0,053 g/s 1,86 g/s 0,32 g/s 

30 MW 1,1 g/s 0,079 g/s 2,77 g/s 0,47 g/s 

 

 
 
 
 
Typical road emision: 
 

 

Number of vehicles 
per hour 

CO (g/ms) NOx (g/ms) CxHy (g/ms) 

100 0,00028 0,00009 0,000028 
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1.000 0,0028 0,0009 0,00028 
5.000 0,014 0,0042 0,0014 
10.000 0,028 0,009 0,0028 
50.000 0,135 0,042 0,0135 
100.000 0,28 0,09 0,028 
 
 
 

Number of vehicles 
per day 

CO (g/ms) NOx (g/ms) CxHy (g/ms) 

1.000 0,000116  0,0000375 0,0000116 
5.000 0,00058  0,00019 0,000058 
10.000 0,00116 0,000375 0,000116 
50.000 0,0058 0,0019 0,00058 
100.000 0,0116 0,00375 0,00116 
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6. Before you begin 
 

Welcome to CASTOR-AIR - software for air dispersion 
modeling. The CASTOR-AIR software allows you to create robust 
and useful numeric simulations that fully make use of the 
graphical user interface. This chapter show you how to sep up 
CASTOR-AIR on your computer. 
 

We can say, with a certain security that the software 
CASTOR-AIR  are one of the best tools, if not the best and 
simpler, to carry out numeric simulations of pollutant 
emissions into the air. It takes just a few minutes to build 
your first numerical simulation. 

 

Due to the features of the software that allows to simulate the 
process of air pollution dispersion immediately, the numeric 
simulation is carried out with a remarkable speed.  

 

You create the graphical interface for your pollutant 
stacks by drawing point sources in a graphical way. You create 
the simulation process by drawing point sources, such as 
stacks, on the CASTOR-AIR window. Next, you set properties for 
the point sources and ambient data to specify such values as 
temperature, pollutant concentration,… Finally, the numeric 
simulation is carrier out. 

 

6.1 CASTOR-AIR Software  
 

Before you attempt to install and use the program, make 
sure your personal computer meets the hardware and software 
requirements shown in the following table. 

 

 System requirements: Windows 95, 98, 2000 and XP 

 CD-ROM drive 

 RAM Memory: 16MB or higher 
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6.2 Installation  
 

 Insert the CD. The CASTOR-AIR CD window appears on your 
screen. 

 Click the button labeled SETUP and follow the 
instructions on the screen. 

 

If the CASTOR-AIR CD window does not appear, the CD autorun 
feature might be disabled on your computer. To install CASTOR-
AIR, open the CD-ROM drive icon, open the PC directory, and 
double-click the Installer icon. 

 

6.3 Starting CASTOR-AIR 
 

Click Start, go to Programs, and choose CASTOR-AIR 5.0. 
Here is the program window after startup. 
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The window has a Menu bar at the top, a Status bar at the 
bottom and a basic tool bar in the window. The program 
commands are available through the menus and toolbar buttons. 
Some commands have associated dialog boxes which you can 
choose additional options. 
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7. Understanding the Workplace 
 

The MS Windows bar doesn’t appear. In this way, you have 
more space to draw. However, and if you want, you can modify 
the properties of the MS Windows bar in the Microsoft Windows 
system. The program window size is fixed and it cannot modify. 
The menu bar lists the menus shown above. When you choose one 
of the menus, the program displays a pull-down list of 
available commands. The menu bar lists: File, View, Sources, 
Ambient data, Tools, Options and About CASTOR-AIR. The program 
window has a basic tool bar at the top. 

 

In the center of the program window, we will draw and we 
will calculate the different polluting processes. We can draw 
using two different planes: parallel to the land surface (XY) 
and perpendicular to the land surface (XZ). There is a grid in 
the XY-plane. The coordinate origin is on the left bottom 
corner (X=0, Y=0) in XY-planes (parallel to the land surface). 
In addition, the coordinate origin is on the left bottom 
corner (X=0, Z=0) in XZ-planes (perpendicular to the land 
surface).  

 

XY-Plane (parallel to land surface):  

 

In such a case, the program window is a XY-plane (parallel to the 
land surface). A pollutant point source (stack) is represented by a 
small square. 

 

In the Status bar at the bottom, we have X,Y and Z coordinate 
values in meters and data on our environmental system. Point 
the mouse where you want in the program window and the X,Y and 
Z values will be shown in the status bar at the bottom. If you 
select XY-Plane, a grid appears. 

 

On the left bottom corner, two different text boxes appear: The 
position of the XY-plane with respect to the land surface (XY-plane 
height) and the pollutant concentration value (micrograms per 
cubic meter, ug/m3). Point the mouse where you want in the 
program window and the concentration value will be shown in the 
text box. Remember that 1g/m3=1mg/L. 
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The pollutant concentrations will be calculated in a parallel 
plane to the land surface (XY-Plane). The plane height will be 
determined by the user (zr).  

 
 

 
 
 
 

All the points of the XY-plane will be to a zr height. The zr 
value is chosen by the user before the calculation. We will be 
able to make many calculations considering different plane 
heights. The different plane heights will be determined by the 
user (zr values). In this way, the physical form of the 
pollutant plume can be studied.  
 
Example: Calculation in the XY-plane, zr=0 (height of the land 
surface). The red square represents a point source (position 

0,2 g/m^3 

Point source  -  Program window  -  
Plane representation 

XY-Plane 

zr 
 

Coordinate origin 
(x=0, y=0, z=0) 
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of the pollutant stack). The red colour represents high 
pollutant concentrations. 
 
 
 

 
 
 
 
XZ-Plane (perpendicular to land surface):  

 

In such a case, the program window is a XZ-plane (perpendicular to 
the land surface). A pollutant point source (stack) is represented by 
a small square. 

 

In the Status bar at the bottom, we have X,Y and Z coordinate 
values in meters and data on our environmental system. Point 
the mouse where you want in the program window and the X,Y and 
Z values will be shown in the status bar at the bottom. 
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On the left bottom corner, a text box appears: the pollutant 
concentration value (micrograms per cubic meter, ug/m3). Point the 
mouse where you want in the program window and the 
concentration value will be shown in the text box. Remember that 
1g/m3=1mg/L. 

 

The pollutant concentrations will be calculated in a 
perpendicular plane to the land surface (XZ-Plane). The plane 
height will be determined by the user (yr).  

 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
  
 
 
 
 
 
All the points of the XZ-Plane will be to a yr height. The yr 
value is chosen by the user before the calculation. We will be 

Coordinate origin 
(x=0, y=0, z=0) 

yr 

Program window –    XZ-
Plane representation  

 
 

0,2 g/m^3 

XZ-Plane 
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able to make many calculations considering different plane 
heights. The different plane heights will be determined by the 
user (yr values). In this way, the physical form of the 
pollutant plume can be studied. Example: Calculation in the XZ-
plane. The fuchsia strip represents a point source (position 
of the pollutant stack). The green line represents land 
surface. The red colour represents high pollutant 
concentrations. 
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We will show you a typical calculation diagram: a Stack (point 
source) in elevated terrain. 
 
 
 
 

 

 

 
 

 
zi=mixing height 
hs=snack height 
he=plume height 
ha=anemometer height 
zr=calculation plane height 
 
 
 
 

zi 

hs 
ha 

he 

zi 

zr 
zi 

hs 

zi 

he 

zr 

ha 

hs 
ha 

he 

Dh 
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where Dh is the effective plume height.In the line and area source 
cases, we have that the effective plume height is zero (Dh=0). 
For example: 

 
 
 

 
 
 
 

 
 

 

 

 

 
 

7.1 Menu Bar 
 

Display the commands you use to build your simulation. 
When you choose one of the menus, the program displays a pull-
down list of available commands. The program window has a 
basic tool bar under the Menu bar. The tool bar provides quick 
access to commonly used commands in the program. You click a 
button on the toolbar once to carry out the action represented 
by that button.  

 

For example, when you choose File in the Menu bar, the 
program displays: 

Road (Dh=0) 
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7.1.1 File 

 
The File Menu contains the tools you use to open, close 

and save new and existing files, and import and export 
graphics. The File Menu lists: New, Open, Save, Import 
Picture, Export Picture, Print, Print Picture and Exit. 

 

New.- This command is to begin a new simulation, deleting all 
that has been made previously.  

 

Save the work with the Save command before clicking the New 
command.  The program doesn't allow to open two files at the same 
time. This way, we can optimize the available memory and the 
calculation speed. 
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Open.- This command is to open an existing file. The program 
files exist as separate files with .sim filename extension. 

 

Save the current work with the Save command before clicking the 
Open command.  The program doesn't allow to open two files at the 
same time. 

 

Save.- This command is to save an existing result.  

 

The process of saving a file is carried out proportionally to the size 
in which the elements are drawn in the screen. Then, the saved file 
will depend on the screen format that we are using (for example, 
1280x1024,…). If we try to read a file, saved in another different 
computer, we will have problems to open it. 

 

Import Picture.- With this command you will be able to import 
images and pictures (previously saved BMP files). These images 
will be background pictures and images for your program 
window. You can display an image by double-clicking the 
filename of a bitmap (BMP). 

 

Many programs and computer applications (AutoCad, 3d Studio, 
ArcView,...) export BMP files. You will be able to load pictures and 
images generated by these programs. 

 

The displayed image size will depend on the size that had when 
it was saved. If it is necessary, modify the picture size 
before loading the image (for example, you can use windows 
Paint, Adobe Photoshop,… ). You will be able to load BMP maps 
generated by AutoCad. 

 

Bitmaps and scanned maps must be loaded into memory and then 
adapted to the program scale (we will make use of the Scale 
command). The X-Axis width (meters) in the program window can 
be easily changed to be able to compare both images 
(simulation results and background maps). Then, the X-Axis 
width (in meters) of the imported map and the X-Axis width (in 
meters) of the program window match together. The imported 
images are not stored physically in the simulation process. 
Terrain elevations (represented on the imported map) don’t 
interact in the simulation process. We haven't the possibility 
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to zoom an imported map with the Zoom command. This command 
only acts in the calculation process. If it is necessary, zoom  
the map before loading the image. 

 

Export Picture.- With this command you will be able to export 
images and pictures (BMP files). These images will contain the 
background picture and the simulation results. 

 

Many programs, computer applications and word processors 
(AutoCad, 3d Studio, ArcView, MS Word,...) import BMP files. You 
will be able to load images generated by CASTOR-AIR. 

 

Print.- The users’ printer drivers and printers impact print 
quality. With this command you can send graphics and text (of 
the simulation results) to a printer. This command provides 
the best printing quality across a variety of printers because 
Windows translate text and graphics from the device-
independent drawing space to the Printer object to best match 
the resolution and abilities of the printer. However, the 
background pictures cannot be printed. 

 

Print image.- This command send a pixel-by-pixel image of the 
program window to the printer. To print with Print image 
command, you must first display that information on the 
program window and then print with this command. This command 
is by far the easiest way to print from your application.  
Because it may send information to the printer at the 
resolution of the user’s screen (typically 96 dots per inch), 
results can be disappointing on printers with much higher 
resolutions (typically 300 dots per inch for laser printers).  

 

Exit.- The Exit command allows you to exit directly from the 
application. 
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7.1.2 View 
 

The View Menu contains the tools you use to view your 
computer screen. The File Menu lists: Zoom, Black background, 
White background, Draw grid lines, Eliminate grid lines, Draw 
picture, Eliminate picture, XY View and XZ View. 

 
Zoom.- We have the possibility to zoom a part of the program 
window with the Zoom command. However, we won't be able to 
enlarge background pictures with this command. If it is 
necessary, zoom the map before loading the background image. 
This command only acts in the calculation process. This way, 
we can place a point source in a side of the computer screen 
and we can calculate the concentrations in another different 
detailed region. 
 
 

 
 
 
To activate the Zoom command, eliminate the background picture 
first. 
 
Black background.- The Black background command allows you to 
have a black background colour in your screen. 
 
White background.- The White background command allows you to 
have a white background colour in your screen. 
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Draw grid lines.- If you select Draw grid lines command, the 
grid appears. 
 
Eliminate grid lines.- If you select Eliminate grid lines 
command, the grid disappears. 
 
Draw picture.-  With this command you will be able to see  
background images and pictures (previously loaded BMP files).  

 
Eliminate picture.- With this command you will eliminate  
background images and pictures (previously loaded BMP files).  
 
XY View.- With this command, you can draw using a plane that 
is parallel to the land surface (XY). 
 
XZ View.- With this command, you can draw using a plane that 
is perpendicular to the land surface (XZ). 
 
 

7.1.3 Source 
 

The Point source Menu lists the possible pollutant 
sources: the point source, line source and area source. 
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Point source.- This is a pollutant point source. The stack 
size is small if we compare it with the size of the area in 
which we are simulating (point source). If you click this 
button, the next dialog box is shown: 

 

 

 

The necessary data is: 

 

Physical stack height (m): This is the physical stack 
height in meters.  

 

Stack gas exit velocity vs (m/s): This is the stack gas exit 
velocity. It can be around 15 m/s. 

 

Stack gas exit temperature (K): The discharge concentration 
of the material of interest (pollutant or tracer) is 
defined as the excess concentration above any ambient 
concentration of that same material. 1g/m3=1ppm in air. 

 

Stack inside diameter (m): This is the stack inside 
diameter. 
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Pollutant emission rate (g/s): This is the pollutant 
emission rate. 

 

Decay coefficient (1/s): This coefficient considers the 
half life of the pollutant if this disappears by means of 
chemical reactions (non-conservative pollutant).  

 

Estimate flow rate: With this button, you can estimate the 
pollutant flow rate if it is unknown. If you know the rate, 
you don't need to use this command. You can write it directly 
in the point source window. If you click this button, the next 
dialog box is shown: 
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If you click the OK button, the next program window is shown 

 

 

 

 

Two blue axis points the place where we can fix the stack 
position. After clicking the program window, you draw the 
stack. 
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The small fuchsia square shows the stack location. We can draw 
all the gas stacks that we want (up to 1,000). To change the 
point source data, we can click the stack location in the 
program window. Then, the point source dialogbox is again 
displayed. We are not able to put two gas stacks in the same 
location. The older is eliminated automatically. 

   

Line source.- This is a pollutant line source. The line width 
is small if we compare it with the size of the area in which 
we are simulating (line source). If you click this button, the 
next dialog box is shown: 
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Here, only some data can be modified. The necessary data is: 

 

Pollutant emission rate (g/m s): This is the pollutant 
emission rate. 

 

Decay coefficient (1/s): This coefficient considers the 
half life of the pollutant if this disappears by means of 
chemical reactions (non-conservative pollutant).  

 

If you click the OK button, the next program window is shown 
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If you click the computer screen and move the mouse, a 
straight line is shown 
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If you click again on the computer screen, a line source is 
drawn 

 
 

 
 
 
 
Area source.- This is a pollutant area source. The area width 
is small if we compare it with the size of the area in which 
we are simulating (area source). If you click this button, the 
next dialog box is shown: 
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Here, only some data can be modified. The necessary data is: 

 

Pollutant emission rate (g/m2 s): This is the pollutant 
emission rate per unit area and second. 

 

Decay coefficient (1/s): This coefficient considers the 
half life of the pollutant if this disappears by means of 
chemical reactions (non-conservative pollutant).  

 

If you click the OK button, the next program window is shown 
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If you click the computer screen and move the mouse, a square  
is shown: 

 

 



                                                                                                                                                              CastorAIR 

 

- 35 - 

 

And if you click again on the computer screen, an area source 
is drawn: 
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7.1.4 Ambient data 
 

Ambient conditions are defined by the land and 
atmospheric conditions in the vicinity of the pollutant 
emission. This Menu lists: Meteorology and Topographic lines. 

  

Meteorology.- CASTOR-AIR analyses, as all mixing zone 
evaluations, are usually carried out under the assumption of 
steady-state ambient conditions. If you click this command, 
the next dialog box is shown: 

 

 

 

The necessary data in the Meteorology command is: 

 

Pasquill stability): Classification scheme that describes 
the degree of atmospheric turbulence. Categories range from 
extremely unstable (A=1) to extremely stable (F=6). 
Unstable conditions promote the rapid dispersion of 
atmospheric contaminants and result in lower air 
concentrations compared with stable conditions. 

 

Wind speed at reference anemometer height (m/s): The 
measurement of wind speeds is usually done using a cup 
anemometer. The cup anemometer has a vertical axis. The 
number of revolutions per minute is registered 
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electronically. 
 

Wind angle (0 to 360 degrees): It is the horizontal angle 
of wind measured clockwise from the North (at the window 
top).  

 

Ambient temperature (K): The temperature of the medium 
surrounding an object.  This is the air temperature at stack 
location.  

 

Mixing height (m): Mixing Height is used by meteorologists 
to quantify the vertical height of mixing in the 
atmosphere. It is the height at which vertical mixing takes 
place. There is a smaller volume which the pollutant can be 
dispersed. There is a seasonal variation of mixing height. 
For Summer daylight hours maximum mixing height can be a 
few thousand feet where as for Winter it can be a few 
hundred feet. It is lowest at night and increases during 
the day.  

 

Anemometer height (m): This is the ambient temperature at 
stack location.  

 

RURAL/URBAN option: This is the RURAL/URBAN terrain 
options. 

 

Obtain K value: With this button, you can estimate the 
Pasquill stability category if it is unknown. If you know 
the K value, you don't need to use this command. You can 
write it directly in the Meteorology window. If you click 
this button, the next dialog box is shown: 
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Topographic lines.- This command is to draw topographical 
lines. If you click this command, the next dialog box is 
shown: 

 

 

 

The height of the contour line can be written in the textbox. 
If you click the Accept button, the next computer screen is 
shown: 
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Then, and if you click the computer screen and move the mouse 
(mouse down), a square is shown and when you mouse up (the 
height of the contour line is different to zero): 
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The area inside this contour has a 10m height. A rectangle 
elevation could be represented by the program in the next way: 
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To draw a small mountain, we can use a lot of small 
rectangles. 

10m 

Y 

X 

X 

Z 

10m 
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A mountain could be represented by the program in the next 
way: 

 

 

 

 
 
 

 

 

 

 

 

 

 

 

X 

Z 
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7.1.5 Tools 
 

The Tools Menu contains the tools you use to process your 
data. The File Menu lists: Temporal average, Delete, Axis 
scale, XY-Calculation, XZ-Calculation, Colour gradient, 
Isolines, Numerical grid and Calculation parameters. When you 
choose Tools in the Menu bar, the program displays: 

 
 

 
 

 
 

Temporal average.- Some discharge data can vary with time 
(velocity of the wind, pollutant rate,...). Taking this into 
account, the program can do temporal averages in the 
calculation. In the CASTOR-AIR software, these data are 
allowed to vary with time. If you click this command, the next 
dialog box is shown: 
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We can write in the text box the number of temporal points per 
average. To be able to make an average, we will take more than 
a temporal point. 

 

The temporary points are elements of an average and we will be 
able to relate them with any temporary instant. That is to say, if we 
have data of winds for every hour of one day (a total of 24) and we 
want to make an average of the pollution in one day, we will be 
able to make a temporal average with 24 temporal points to 
calculate the daily average. 

 

Each temporary point that we average represents the data in a 
hour of time. If we have monthly data, and we want to make an 
annual average, we will be able to average with 12 temporary 
points (the twelve months). Then, and if you click the OK 
button, the next dialog box is shown: 
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The window allows to visualize the data to make the average. 
It also allows to modify the data or to change them. We have 
two groups of data that can vary in time: Meteorology and 
Source data.  

 

At the top of the dialog box, two different text boxes appear: source 
label and temporal point label.  We can click both arrows to change 
these values and to visualize the data. 

 

Every time that you enable a new average, the software 
allocates to all temporal points the same quantities. These 
quantities coincide with the values that we had in the 
Meteorology and Source dialogboxes before enabling an average. 
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To modify the ambient and emission data in the temporal 
average, we can click Meteorology and Source buttons in the 
dialogbox. Then, and if you click the Meteorology button, the 
next dialog box is shown: 

 

 

 

 

Some data of the dialog box cannot be modified: the anemometer 
height and the RURAl/URBAN terrain option can not be modified. 
There is not interest in varying this data in time. To modify 
these data, we will have before to disable the temporal 
average and to open the source and Meteorology dialogboxes in 
the source Menu and in the ambient data Menu, respectively. To 
disable the temporary average, we will have to click the 
Temporal average command and to write 1 in the textbox of the 
Number of temporal points. 

 

If you click the source button in the Temporal average 
dialogbox, the next dialog box is shown: 
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Some data of the dialog box cannot be modified: the physical 
stack height, the stack inside diameter and the decay 
coefficient. There is not interest in varying this data in 
time To modify these data, we will have before to disable the 
temporal average and to open the source and Meteorology 
dialogboxes in the source Menu and in the ambient data Menu, 
respectively. To disable the temporary average, we will have 
to click the Temporal average command and to write 1 in the 
textbox of the Number of temporal points. 

 

Before running the calculation it is convenient to check the 
data that we have in the average. 

 

If we enable an average with more than a temporal point, and 
if later we increase the number of temporal points, it is 
necessary to be careful since there are data that can have 
null value. The ideal procedure is to define well, and from 
the beginning, the number of temporal points before writing 
the values for the average. If we want to modify an activated 
average it can be more comfortable to delete the activated 
average and then to define one new. To delete a temporal 
average, we will have to click the Temporal average command 
and to write 1 in the textbox of the Number of temporal 
points. 
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Delete.- This command is used to delete pollutant sources that 
we don't want in the simulation. If you click the Delete 
button, the next program window is shown: 

 

 

 

Clicking on these points we will delete them of the screen and 
of the calculation. 

 

Scale.- With this command, we will decide the work area size 
in the simulation process. It is an important tool because 
with their good use we will be able to interpret and to 
extract interesting data of the numeric simulation. The scale 
is defined according to the width in meters that we want to 
associate to the X-Axis of our program window. If you click 
the Scale button, the next program window is shown: 
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In this window we will be able to choose the number of meters 
that we want to have in the X-Axis. When we have the value 
written in the textbox, we will make click with the mouse on  
Accept button and this value will be modified and the previous 
window will disappear. If we click the Cancel button it closes 
the window without modifying the value. This command will be 
used before using the calculation command, since this 
parameter should be perfectly defined before making the 
simulation. When we use this command the program, we clean the 
whole screen of the computer and we lose all the elements of 
the simulation placed previously. If we don't want to lose the 
information obtained until the moment we will use the Save 
command before executing the Scale command. 

 

In certain situations, it can be interesting to have a high 
number of meters in the X-Axis for a better visualization. To 
illustrate the use of this command, we will carry out the same 
simulation varying the scale. We will use three different 
scales. Here, the width of the X-Axis is 1,000 m. 
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Here, the width of the X-Axis is 10,000 m. 
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Here, the width of the X-Axis is 100 m. 

 

 

 

 

As we can see, when the X-Axis is 1,000 m, it is when we have 
a clearer representation, where it is shown the value of the 
maximum point and the concentration lines clearly.  

 

XY-Calculation and XZ-Calculation.- The calculation commands 
run the necessary algorithm to carry out the numeric 
simulation. We will run the command after having fixed the 
necessary data for the simulation, that is to say, the 
sources, the ambient data, the scale,... If we change any 
initial data (as the position of the source, velocity of the 
wind,...),  we will need to run the command again so that this 
is reflected in the result. We will be able to choose between 
XY-Calculation and XZ-Calculation commands to obtain different 
pollution maps. If we make click on XY-Calculation command, we 
open the following window : 
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In this window we will be able to choose if we want to carry 
out the calculation in the land surface or to a certain height 
(two options). In the first option, the calculation of the 
pollutant concentrations will be carried out at surface 
height. If we choose the option for the calculation to a 
certain height, we will write in the textbox the plane height 
in which we will obtain the results (0m for the surface of the 
sea). 

 

If we make click on XZ-Calculation command, we open the 
following window : 
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In this window we will be able to write the distance to the 
origin (inferior left point of the screen) of the XZ-plane 
that is perpendicular to the land surface. On this plane we 
will carry out the XZ-Calculation. 

 

The program works in the following way: while it calculates, the 
machine centers all the capacity of the CPU in the calculation, 
stopping the other tasks of Windows. If we want to stop a tedious 
calculation, we will be able to make it making use of the keys 
CTRL+ALT+DEL.  

 

Note about this command.- Near the source, we can find 
diferences between both XY-calculation and XZ-calculation 
commads. The application uses a numerical grid for valuing an 
exponential function. The small differences between adjacent 
points, when the grid is implemented, can cause different 
concentration results due to the exponential behaviour near 
the source. Far away from the source, these differences can be 
neglected.   
 

Colour gradient.- This command is to draw maps of pollution 
making use of a colour gradient. It is specially useful when 
the variation of the concentration of pollutants is very 
strong in a very short distance. The program takes the maximum 
value of the concentration and it assigns to the maximum the 
red colour. Then, the program assigns the different colours to 
the grade of pollution in a qualitative way. We will be able 
to obtain the exact values locating the arrow of the mouse on 
any point and looking at the inferior right textbox of the 
program.  

 

Isolines.- This command is of effect contrary to the previous 
one. We will use this command with the purpose of obtaining 
the isolines again. This way we will be able to change 
representation easily making use of these last two commands. 

 

Numerical grid.- This command allows us another alternative 
representation of the calculated concentrations. It 
establishes a numerical grid throughout the calculation 
screen. It is specially useful if we load topographical 
planes, because with the other representations there are many 
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images in the screen. If you click the Numerical grid button, 
the next program window is shown: 

 

 

 

 

Calculation parameters.- This command will show us the 
parameters that we have assigned before carrying out the 
calculation. It is convenient their use with the purpose of 
verifying that we have written the parameters correctly. Once 
finish the calculation, the command shows us, also, the value 
of the maximum concentration and its position.  

 

 

7.1.6 Options 
 

The Options Menu includes all the elements for the 
numeric configuration of the simulations. We will use these 
commands before using the calculation command because these 
parameters should be perfectly defined before running the 



                                                                                                                                                              CastorAIR 

 

- 55 - 

 

simulation. The Options Menu lists: Grid size, Number of 
Isolines, Calculation colours, Fonts, Calculation model and 
Odor units. When you choose Options in the Menu bar, the 
program displays: 

 

 

 

Grid size.- The grid size is an important parameter in the 
configuration of the system. We will decide the number of 
calculation points in the grid that we will take to make the 
simulation. As we increase the number of points, the computer 
will take much more time in carrying out the calculation but 
the result will be much more exact. If you click the Grid size 
command, the next program window is shown: 
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In this window we will be able to choose the number of grid 
points (calculation points) that we want to have in the X-
Axis. The number of points to calculate will increase 
quadratically with the number of grid points along the X-Axis 
N, that is to say, it will increase as N2. 

 

To increase the number of grid points produces that the program 
needs much more RAM-memory. If we take such a high number of 
grid points that it overcomes the available memory of the PC, the 
computer will be blocked. 

 

Number of isolines.- This command is an auxiliary tool for 
making the maps of pollutant concentration. We will decide the 
number of isolines in the screen that we will take to make the 
representation. In certain situations, it can be interesting 
to have a high number of isolines for a better visualization. 
We will use this command before using the calculation command 
because this parameter should be perfectly defined before 
running the simulation. If you click the Number of isolines 
button, the next program window is shown: 
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In this window we will be able to choose the number of 
isolines that we want to have in our computer screen. To 
calculate the lines, the program also considers to the maximum 
point as a line. 

 

To illustrate the use of this command, we will carry out the 
same simulation varying the number of isolines. We will use 
three different number of isolines. Here, the number of 
isolines is 17.  
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Here, the number of isolines is 3. 

 

 

 

Here, the number of isolines is 7. 



                                                                                                                                                              CastorAIR 

 

- 59 - 

 

 

 

 

Calculation colours.- By means of this command, we will be 
able to change the colors of the isolines, of the maximum 
point and of the point sources. 

 

Fonts.- This command is an auxiliary tool for making the maps 
of pollutant concentration. In this command we have three 
different options. We can choose: number of decimal places, 
font size and source label (Yes/No). 
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Calculation model.- This command is an auxiliary tool for 
changing the calculation model.  

 

Odor units.- This command is an auxiliary tool for using odor 
units.  

 

 

 

7.1.7 GIS 
 

In this option it can be found all necessary to work with 
geographical information system.  

 

Coordinates of the origin.- With this command we can choose 
the value for the origin of coordinates. It is initially in 
the left bottom corner of the program window. It is possible 
to work with geographic and Cartesian coordinates. 
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Reference points.- With this command we can decide the 
coordinate values of a point, that we previously know, in the 
map in order to have a referenced system. It is possible to 
work with geographical and Cartesian coordinates. After that, 
it will be possible to export the results to a GIS system.  

  

 

 

 
Radius of curvature.- By means of this command, you can choose 
a value for the Earth radius. This radius can be slightly 
modified to adjust the reference system with the available 
data. The program considers the Earth as a perfect sphere with 
an exact radius. We know that this is not exactly true. This 
option is to correct this kind of effects.  
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Scale calculation.- With this command it is possible to 
estimate the map scale that corresponds to a background image, 
that has trees previously imported by the user. It is 
necessary to know the distance between to different points in 
the map. After introducing the distance data, you can click 
consecutively both points, and the scale will be automatically 
calculated. 

 
  

 

 

 

 

 

 

 

 

 

 

Export maximum, concentrations,….- These are to export the 
different elements of the programs (isolines, source 
positions,…) to Microsoft EXCEL csv file. To import without 
problems with Arcview we have used the english format system 
for the numbers. For example, one euro and 30 cents is 1.30 
euros (NOT 1,30!) in the english format.  
If you are using the spanish format, for example, when you 
open the exported file with EXCEL you obtain “al numbers in 
the same box”. In such a case, the best way is to change your 
number format in your computer. It is very easy. Just go to 
WINDOWS >> START >> CONTROL PANEL >> REGIONAL CONFIGURATION 
and look for english format before opening with your EXCEL 
program. 
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7.1.8 3D 
 

The 3D commands are for a qualitative representation, not 
quantitative. The system generates random points to help you 
to obtain a 3D view of the pollution process. The pollution 
concentration value that appears in the screen is an 
orientative value. In the 3D options you can modify the number 
of random points and other parameters.  

 

The 3D window is an extension of the 2D XY window. The X 
coordinate, Y coordinate and concentration value that appear 
on the bottom of the screen correspond to the XY plane view. 
The calculated XY data will be deleted after a 3D calculation. 
The PRINT command only prints the XY view. To print in 3D, you 
need to use the PRINT IMAGE command. Or you can save a BMP 
file and print such a file with an another standard program 
(windows PAINT, ...). 

 

7.2 Icon bar 
 

The menu bar display the commands you use to build your 
simulation. When you choose one of the menus, the program 
displays a pull-down list of available commands. The program 
window has a basic icon bar under the Menu bar. The icon bar 
provides quick access to commonly used commands in the 
program. You click a button on the icon bar once to carry out 
the action represented by that button.  

 

 

 

 

8. Application structure 
 

 

In this section, the general structure of the application 
will be shown. The Options Menu includes all the elements for 
the numeric configuration of the simulations. We will use 
these commands before using the calculation command because 
these parameters should be perfectly defined before running 
the simulation. 
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 If we change any initial data (as the position of the 
source, velocity of the wind,...),  we will need to run the 
command again so that this is reflected in the result. We will 
be able to choose between XY-Calculation and XZ-Calculation 
commands to obtain different pollution maps.  

 

 

 

 

Colour gradient, Isolines and Numerical grid commands should 
be applied after running the calculation. 

 
 
 

 
Scale 

 
Grid size 

 
Ambient data 

 
Calculation 
parameters 

 
Sorces 

 
 

Calculation 

 
Colour gradient 

 
Numerical grid 

 
Isolines 
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9. Mathematical algorithms 

Symbols 

Symbol / Definition 
A = Linear decay term for vertical dispersion in Schulman-Scire downwash 
(dimensionless) 
Ae= Effective area for open pit emissions (dimensionless) 
D = Exponential decay term for Gaussian plume equation (dimensionless) 
DB= Brownian diffusivity (cm/s) 
Dr= Relative pit depth (dimensionless) 
de= Effective pit depth (m) 
dp= Particle diameter for particulate emissions (µm) 
ds= Stack inside diameter (m) 
Fb= Buoyancy flux parameter (m4/s3) 
Fd= Dry deposition flux (g/m2) 
Fm= Momentum flux parameter (m4/s2) 
FQ= Plume depletion factor for dry deposition (dimensionless) 
FT= Terrain adjustment factor (dimensionless) 
Fw= Wet deposition flux (g/m2) 
f= Frequency of occurrence of a wind speed and stability category 
combination (dimensionless) 
g= Acceleration due to gravity (9.80616 m/s2) 
hb= Building height (m) 
he= Plume (or effective stack) height (m) 
hs= Physical stack height (m) 
hter= Height of terrain above stack base (m) 
hs= Release height modified for stack-tip downwash (m) 
hw= Crosswind projected width of building adjacent to a stack (m) 
k= von Karman constant (= 0.4) 
L= Monin-Obukhov length (m) 
Ly= Initial plume length for Schulman-Scire downwash sources with enhanced 
lateral plume spread (m) 
Lb= Lesser of the building height and crosswind projected building width 
(m) 
_= Alongwind length of open pit source (m) 
P(x,y)= Profile adjustment factor (dimensionless) 
p= Wind speed power law profile exponent (dimensionless) 
QA= Area Source pollutant emission rate (g/s) 
Qe= Effective emission rate for effective area source for an open pit 
source (g/s) 
Qi= Adjusted emission rate for particle size category for open pit 
emissions (g/s) 
Qs= Pollutant emission rate (g/s) 
Qt= Total amount of pollutant emitted during time period t (g) 
R= Precipitation rate (mm/hr) 
Ro= Initial plume radius for Schulman-Scire downwash sources (m) 
R(z,zd)= Atmospheric resistance to vertical transport (s/cm) 
r= Radial distance range in a polar receptor network (m) 
ra= Atmospheric resistance (s/cm) 
rd= Deposition layer resistance (s/cm) 
s= Stability parameter = FUNC {g {{¶ theta}/¶z } over {T_a}} 
S= Smoothing term for smoothing across adjacent sectors in the Long Term 
model (dimensionless) 
SCF= Splip correction factor (dimensionless) 
Sc= Schmidt number = FUNC { upsilon /D_B } 
(dimensionless) 
St= Stokes number (dimensionless) 
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Ta= Ambient temperature (K) 
Ts= Stack gas exit temperature (K) 
uref= Wind speed measured at reference anemometer height (m/s) 
us= Wind speed adjusted to release height (m/s) 
u*= Surface friction velocity (m/s) 
V= Vertical term of the Gaussian plume equation (dimensionless) 
Vd= Vertical term with dry deposition of the Gaussian plume equation 
(dimensionless) 
vd= Particle deposition velocity (cm/s) 
vg= Gravitational settling velocity for particles (cm/s) 
vs= Stack gas exit velocity (m/s) 
X= X-coordinate in a Cartesian grid receptor network (m) 
xo= Length of side of square area source (m) 
Y= Y-coordinate in a Cartesian grid receptor network (m) 
q= Direction in a polar receptor network (degrees) 
x= Downwind distance from source to receptor (m) 
xy= Lateral virtual point source distance (m) 
xz= Vertical virtual point source distance (m) 
xf= Downwind distance to final plume rise (m) 
x*= Downwind distance at which turbulence dominates entrainment (m) 
y= Crosswind distance from source to receptor (m) 
z= Receptor/terrain height above mean sea level (m) 
zd= Dry deposition reference height (m) 
zr= Receptor height above ground level (i.e. flagpole) (m) 
zref= Reference height for wind speed power law (m) 
zs= Stack base elevation above mean sea level (m) 
zi= Mixing height (m) 
z0= Surface roughness height (m) 
ß= Entrainment coefficient used in buoyant rise for Schulman-Scire downwash 
sources = 0.6 
ßj= Jet entrainment coefficient used in gradual momentum plume rise 
calculations FUNC {~=~{1 over 3} + {{u_s} over {v_s}}} 
Dh= Plume rise (m) 
dq/dz= Potential temperature gradient with height (K/m) 
L= Precipitation scavenging ratio (s-1) 
l= Precipitation rate coefficient (s-mm/hr)-1 
pi = 3.14159 
Gamma= Decay coefficient = 0.693/T1/2 (s-1) 
yH= Stability adjustment factor (dimensionless) 
f= Fraction of mass in a particular settling velocity category for 
particulates (dimensionless) 
rho= Particle density (g/cm3) 
rhoAIR= Density of air (g/cm3) 
sigy= Horizontal (lateral) dispersion parameter (m) 
sigyo= Initial horizontal dispersion parameter for virtual point source (m) 
sigye= Effective lateral dispersion parameter including effects of buoyancy-
induced dispersion (m) 
sigz= Vertical dispersion parameter (m) 
sigzo= Initial vertical dispersion parameter for virtual point source (m) 
sigze=Effective vertical dispersion parameter including effects of buoyancy-
induced dispersion (m) 
U=Viscosity of air = 0.15 cm2/s 
µ=Absolute viscosity of air = 1.81 x 10-4 g/cm/s 
C=Concentration (µg/m3) 
cd=Concentration with dry deposition effects (µg/m3) 
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The mathematical model that the software uses provides options 
to model emissions from a wide range of sources that might be 
present at industrial areas and urban areas. The basis of the 
model is the straight-line, steady-state Gaussian plume 
equation, which is used to model simple point source emissions 
from stacks, roads, storage piles and conveyor belts. Emission 
sources are categorized into three basic types of sources: 
point sources, line sources and area sources. The algorithms 
used to model each of these source types are described in 
detail in the following sections.  

The DISPER dispersion model accepts meteorological data 
records to define the conditions for plume rise and transport. 
The model estimates the concentration value for each source 
and receptor combination and calculates user-selected 
averages.  

 

9.1 Point source emissions 

The model uses a steady-state Gaussian plume equation to model 
emissions from point sources, such as stacks.  

 

9.1.1 The Gaussian Equation 

The model for stacks uses the steady-state Gaussian plume 
equation for a continuous elevated source. For each source, 
the origin of the stack coordinate system is placed at the 
ground surface at the base of the stack. The x axis is 
positive in the downwind direction, the y axis is crosswind 
(normal) to the x axis and the z axis extends vertically. The 
fixed receptor locations are converted to each source's 
coordinate system. The hourly concentrations calculated for 
each source at each receptor are summed to obtain the total 
concentration produced at each receptor by the combined source 
emissions. 

For a Gaussian plume, the hourly concentration at downwind 
distance x (meters) and crosswind distance y (meters) is given 
by: 

 
c =(Q K V D/2 pi us sigy sigz) exp[-0.5(y/sigy)2] (1) 

 

where: 

Q= pollutant emission rate (mass per unit time) 
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K= a scaling coefficient to convert calculated concentrations to 
desired units (default value of 1 x 106 for Q in g/s and concentration 
in µg/m3) 

V= vertical term (See Section 1.1.6) 

D= decay term (See Section 1.1.7) 

sigy,sigz= standard deviation of lateral and vertical concentration 
distribution (m) (See Section 1.1.5) 

us= mean wind speed (m/s) at release height (See Section 1.1.3) 

 

9.1.2 Downwind and Crosswind Distances 

The model uses a Cartesian receptor network. All receptor 
points are converted to Cartesian (X,Y) coordinates prior to 
performing the dispersion calculations. In the Cartesian 
coordinate system, the X axis is positive to the east of the 
user-specified origin and the Y axis is positive to the north. 
The user must define the location of each source with respect 
to the origin of the grid using Cartesian coordinates. If the 
X and Y coordinates of the source are X(S) and Y(S), the 
downwind distance x to the receptor, along the direction of 
plume travel, is given by: 

 
x=-[X(R)-X(S)]sin(WD)-[Y(R)-Y(S)]cos(WD)  (2) 

 

where WD is the direction from which the wind is blowing. The 
downwind distance is used in calculating the distance-
dependent plume rise and the dispersion parameters. The 
crosswind distance y to the receptor from the plume centerline 
is given by: 

 

 
y=-[X(R)-X(S)]cos(WD)-[Y(R)-Y(S)]sin(WD)  (3) 
 

 

9.1.3 Wind Speed Profile 

The wind power law is used to adjust the observed wind speed, 
uref, from a reference measurement height, zref, to the stack or 
release height, hs. The stack height wind speed, us, is used in 
the Gaussian plume equation. The power law equation is of the 
form: 
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us=uref(hs/zref)p  (4) 
 

where p is the wind profile exponent. Values of p may be 
provided by the user as a function of stability category and 
wind speed class. Default values are as follows: 

Stability Category Rural Exponent Urban Exponent 

A 0.07 0.15 

B 0.07 0.15 

C 0.10 0.20 

D 0.15 0.25 

E 0.35 0.30 

F 0.55 0.30 

The stack height wind speed, us, is not allowed to be less than 
1.0 m/s. 

 

9.1.4 Plume Rise Formulas 

The plume height is used in the calculation of the Vertical 
Term. The distance dependent momentum plume rise equations are 
used to determine if the plume is affected by the wake region 
for building downwash calculations.   

Stack-tip Downwash. 

In order to consider stack-tip downwash, modification of the 
physical stack height is performed. The modified physical 
stack height hs is found from: 

 
hs’=hs+2ds[(vs/us)-1.5]  for vs<1.5us      (5 

or 

hs’=hs     for  vs> o =1.5us (6) 
 

where hs is physical stack height (m), vs is stack gas exit 
velocity (m/s), and ds is stack top diameter (m). If stack tip 
downwash is not considered, hs’= hs in the following equations. 

Buoyancy and Momentum Fluxes. 
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For most plume rise situations, the value of the Briggs 
buoyancy flux parameter, Fb (m4/s3), is needed 

 
 

Fb=gvsds2(DT/4Ts) (7) 

 

where DT = Ts - Ta, Ts is stack gas temperature (K), and Ta is 
ambient air temperature (K). 

For determining plume rise, the momentum flux parameter, Fm 
(m4/s2), is calculated based on the following formula: 

 
Fm=gvs2ds2(Ta/4Ts) (8) 
 

Unstable or Neutral - Crossover Between Momentum and Buoyancy. 

For cases with stack gas temperature greater than or equal to 
ambient temperature, it must be determined whether the plume 
rise is dominated by momentum or buoyancy. The crossover 
temperature difference, (DT)c, is determined as follows: 

for Fb < 55, 

 
(DT)c=0.0297 Ts(vs/ds2)1/3  (9) 

 

and for Fb >= 55, 

 
(DT)c=0.00575 Ts(vs2/ds)1/3  (10) 

 

If DT, exceeds or equals (DT)c, plume rise is assumed to be 
buoyancy dominated, otherwise plume rise is assumed to be 
momentum dominated. 

Unstable or Neutral - Buoyancy Rise. 

For situations where DT exceeds (DT)c as determined above, 
buoyancy is assumed to dominate. The distance to final rise, 
xf, is assumed to be 3.5x*, where x* is the distance at which 
atmospheric turbulence begins to dominate entrainment. The 
value of xf is calculated as follows: 

for Fb < 55: 

 
xf=49Fb5/8  (11) 
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and for Fb >= 55: 

 
xf=119Fb2/5  (12) 

 

The final effective plume height, he (m), is determined as 

for Fb < 55: 

 
he=hs+(21.425 Fb3/4/us) (13) 

 

and for Fb = 55: 

 
he=hs+(38.71 Fb3/5/us)  (14) 

 

Unstable or Neutral - Momentum Rise. 

For situations where the stack gas temperature is less than or 
equal to the ambient air temperature, the assumption is made 
that the plume rise is dominated by momentum. If DT is less 
than (DT)c, the assumption is also made that the plume rise is 
dominated by momentum. The plume height is calculated as: 

 
he=hs+3ds(vs/us)  (15) 

 

Briggs suggests that this equation is most applicable when 
vs/us is greater than 4. 

Stability Parameter. 

For stable situations, the stability parameter, s, is 
calculated: 

s=g[(dT/dz)/Ta]  (16) 
 

As a default approximation, for stability class E (or 5) dT/dz 
is taken as 0.020 K/m, and for class F (or 6), dT/dz is taken 
as 0.035 K/m. 

Stable - Crossover Between Momentum and Buoyancy. 

For cases with stack gas temperature greater than or equal to 
ambient temperature, it must be determined whether the plume 
rise is dominated by momentum or buoyancy. The (DT)c  is 
determined and solving for DT, as follows: 
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(DT)c=0.019582 Ts vs s1/2  (17) 
 

If the difference between DT exceeds or equals (DT)c, plume 
rise is assumed to be buoyancy dominated, otherwise plume rise 
is assumed to be momentum dominated. 

Stable - Buoyancy Rise. 

For situations where DT exceeds (DT)c as determined above, 
buoyancy is assumed to dominate. The distance xf is determined 
by  

 
xf=2.0715 us s-1/2  (18) 

 

The plume height, he, is determined by  

 

he=hs+2.6 [Fb/(uss)]1/3  (19) 

 

Stable - Momentum Rise. 

Where the stack gas temperature is less than or equal to the 
ambient air temperature, the assumption is made that the plume 
rise is dominated by momentum. Then, 

 

he=hs+1.5[Fm/(uss1/2)]1/3  (20) 

 

The equation for unstable-neutral momentum rise is also 
evaluated. The lower result of these two equations is used as 
the resulting plume height. 

 

All Conditions - Distance Less Than Distance to Final Rise. 

Where gradual rise is to be estimated for unstable, neutral, 
or stable conditions, if the distance downwind from source to 
receptor, x, is less than the distance to final rise: 

 

he=hs+1.60 [(Fb x2)1/3/us]  (21) 
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This height will be used only for buoyancy dominated 
conditions; should it exceed the final rise for the 
appropriate condition. For momentum dominated conditions, the 
following equations are used to calculate a distance dependent 
momentum plume rise: 

a) unstable conditions: 

he=hs+[3Fmx/(betj2us2)]1/3  (22) 
 

where x is the downwind distance, with a maximum value xmax: 

 

xmax=4ds(vs+3us)/(vsus) for Fb=0    (23) 
 
xmax=49 Fb5/8   for 0 < Fb < 55 m2s3  (24) 

 
xmax=119 Fb2/5   for Fb > 55 m2s3  (25) 
 

b) stable conditions: 

he=hs+(3Fm)1/3{sin[x s1/2/us]}1/3[betj2uss1/2]-1/3 (26) 
 

where x is the downwind distance, with a maximum value xmax: 
 

xmax=0.5 pi us/s1/2  (27) 
 

The jet entrainment coefficient, betj, is given by, 

 

betj=(1/3)+(us/vs)  (28) 
 

If the distance-dependent momentum rise exceeds the final rise 
for the appropriate condition, then the final rise is 
substituted instead. 

 

9.1.5 The Dispersion Parameters 

Point Source Dispersion Parameters: 

Equations that approximately fit the Pasquill-Gifford curves 
are used to calculate sigy and sigz (in meters) for the rural 
mode. The equations used to calculate sigy are of the form: 
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sigy=465.11628 x tan (TH)  (29) 

 

where: 

 

TH=0.017453293[c - d ln(x)] (30) 

 

In both Equations the downwind distance x is in kilometers. 
The equation used to calculate sigz is of the form: 

 

sigz=axb (31) 

 

where the downwind distance x is in kilometers and sigz is in 
meters.  

Procedures Used to Account for Buoyancy-Induced Dispersion. 

The method of Pasquill is used to account for the initial 
dispersion of plumes. With this method, the effective vertical 
dispersion sze is calculated as follows: 

 

sigze=[sigz2 +(Dh/3.5)]1/2  (32) 

 

where sigz is the vertical dispersion due to ambient turbulence 
and Dh is the plume rise due to momentum or buoyancy. The 
lateral plume spread is: 

 

sigye=[sigy2 +(Dh/3.5)]1/2  (33) 

 

where sigy is the lateral dispersion due to ambient turbulence. 
It should be noted that Dh is the distance-dependent plume 
rise if the receptor is located between the source and the 
distance to final rise, and final plume rise if the receptor 
is located beyond the distance to final rise.  
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9.1.6 The Vertical Term 

The Vertical Term (V) accounts for the vertical distribution 
of the Gaussian plume. It includes the effects of source 
elevation, receptor elevation and plume rise. In addition to 
the plume height, receptor height and mixing height, the 
computation of the Vertical Term requires the vertical 
dispersion parameter (sigz). The Vertical Term without 
deposition effects is then given by: 

 

V= exp{-0.5 [(zr-he)/ sigz]2}+exp{-0.5 [(zr+he)/ sigz]2}+ 
 
+{exp[-0.5 (H1/sigz)2]+exp[-0.5 (H2/sigz)2]}i=1,2,...+ 
 
+{exp[-0.5 (H3/sigz)2]+exp[-0.5 (H4/sigz)2]}i=1,2,... 

 
(34) 

where: 

he = hs + Dh 

H1 = zr - (2izi - he) 

H2 = zr + (2izi - he) 

H3 = zr - (2izi + he) 

H4 = zr + (2izi + he) 

zr = receptor height above ground (flagpole) (m) 

zi = mixing height (m) 

The infinite series term in Equation {} accounts for the 
effects of the restriction on vertical plume growth at the top 
of the mixing layer. This equation assumes that the mixing 
height in rural and urban areas is known for all stability 
categories. 

  

The model make the following assumption about plume behavior 
in elevated simple terrain (terrain that exceeds the stack 
base elevation but is below the release height): 

• The plume axis remains at the plume stabilization 
height as it passes over elevated or depressed terrain. 

• The mixing height is terrain following. 
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• The wind speed is a function of height above sea level. 

Thus, a modified plume stabilization height he_ is substituted 
for the effective stack height he in the Vertical Term given by 
Equation (1-50). For example, the effective plume 
stabilization height at the point x, y is given by: 

 

h’e=he+zs-z(x,y)  (35) 

where: 

zs= height above mean sea level of the base of the stack (m) 

z(x,y)= height above mean sea level of terrain at the receptor location 
(x,y) (m) 

 

It should also be noted that, the ISC models truncate terrain 
at stack height as follows: if the terrain height z - zs 
exceeds the source release height, the elevation of the 
receptor is automatically chopped off at the physical release 
height. The user is cautioned that concentrations at these 
complex terrain receptors are subject to considerable 
uncertainty.  

 

9.1.7 The Decay Term (D) 

The Decay Term is a simple method of accounting for pollutant 
removal by physical or chemical processes. It is of the form: 

 

 
D=exp(-psi x/us) for psi > 0 (36) 

 

D=0    for psi = 0 (37) 

 

where: 

psi= the decay coefficient (s-1) (a value of zero means decay is not 
considered) 

x= downwind distance (m) 

For example, if T1/2 is the pollutant half life in seconds, the 
user can obtain y from the relationship: 
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psi=0.693/T1/2  (38) 

 

The default value for psi is zero. That is, decay is not 
considered in the model calculations unless y is specified. 
However, a decay half life of 4 hours (y = 0.0000481 s-1) 
corresponds to SO2 when modeled. 

 

9.2 Non-point source emissions 

 

The CASTOR-AIR model include algorithms to model line and area  
sources, in addition to point sources. These non-point source 
options of the model are used to simulate the effects of 
emissions from a wide variety (conveyor belts, rail lines, 
area sources,…). The area source model is used to simulate the 
effects of fugitive emissions from sources such as storage 
piles and slag dumps.  

 
In this application, the area and line sources (non-point 
sources) are represented by small many intervals (point 
sources). The program simulates the non-point sources solving 
each one of the defined intervals and calculating the total 
concentration. A great number of point sources simulates the 
geometry of these non-point sources. 
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